
101 學年度技職校院策略聯盟辦理樟樹國中學生
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主辦單位：中華科技大學 電機工程系 

協辦單位：中華科技大學 教務處綜合業務組 

指導單位：教育部 技職司 

 
 

民 國 1 0 2 年 5 月 1 日 



 

樟樹國中體驗營議程 
 

時   間 內   容 

12：20- 

13：00 
樟樹國中到中華科大 

13：00- 

13：10 
報到 

13：10- 

13：30 

（電機系簡介） 

謝宗煌主任 

13：30- 

14：10 

第一場演講（Android 手機應用程式開發） 

許地申老師 

14：10- 

14：30 
休息 

14：30- 

15：10 

第二場演講（動畫設計實務） 

柯德祥老師 

15：10 賦歸 
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電機系畢業生就業市場 

電力與
電力電
子領域 

控制與
訊號處
理領域 

通訊與
光電應
用領域 

製造業 

服務業 

  設備產品之研發、設計、製造 

 系統工程之規劃、設計、監造、施工 

 系統設備之管理營運、保養維修 

 設備產品之銷售 

電力設備、電子設備、光電設備、照明設備、通訊設備、
資訊設備、運輸設備、能源設備、動力設備、空調設備、
家電設備、監控設備、醫療設備、多媒體設備等之製造。 

電力工程、資訊工程、通訊工程、空調工程、運輸工程、
照明工程、光電工程、多媒體工程、門禁監控工程、醫
療工程、能源工程、機電工程、電子工程、建築工程等。 

行政機關、金融機構、台電、台鐵、高鐵、捷運、台糖、
台鹽、電信局、中油、中鋼、中船、自來水廠、郵政、
菸酒公賣局、動物園、路燈管理等。 

設備產品代理商、經銷商。 

研發工程師 

設計工程師 

製程工程師 

測試工程師 

維運工程師 

銷售工程師 
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六大新興產業 四大智慧型產業 

                  1.雲端計算 

                  2.智慧電動車 

                  3.發明專利產業化 

                  4.智慧綠建築 

電力與
電力電
子領域 

通訊與
光電應

控制與
訊號處
理領域 系

統
整
合

人
才 
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http://www.youtube.com/watch?v=YHeKnLxfFYA 
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經建會專業科技人力供需推估 
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健全智慧電動車友善使用環境  
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預  期  效  益 

產業效益 

(1)製造業：智慧電動車產量目標105年超過6萬輛 (含外
銷1.5萬輛)，產值超過1200億元 (整車約900億元，零組
件約300億元)。 

(2)服務業：目標105年創造智慧電動車服務業312億元。 

(3)就業人口：目標105年創造2.4萬以上就業人口。 

提升臺灣競爭力 

(1)智慧電動車產業產值躍升TOP5。 

(2)智慧電動車國際品牌排名至TOP10。 
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台達電子成功開發電動車整車電力動力系統 
http://auto.msn.com.tw/news_content.aspx?sn=0911270008 



                    電機工程系-102年度宣導簡報 

8



                    電機工程系-102年度宣導簡報 

9



                    電機工程系-102年度宣導簡報 

10

學生就業 
歷年畢業生： 

• 張恆耀宸鴻光電技術長 

• 張通榮 基隆市  市長 

• 張永豐 吉鴻電子股份有限公司  
董事長 

• 陳世通 隆通工程公司董事長 

• 林世國 台北捷運機電工程師 

• 李宏修 交通部高速鐵路工程局  
正工程司兼科長 

• 李正彥 Panasonic主任工程師 

• 魏騰輝 中鼎工程公司  專案經理 

• 吳昌宜 精業技術顧問 

• 王子龍 勝華科技工程師 

• 劉競文 中芯半導體經理 

• 余信達 東元電機  業務暨智權經
理 

• 謝佳源 BENQ 資深工程師 

 
– 莊中緯 仁寶電子工程師 

– 郭俊瑋 奇美電子專案經理 

– 鄭百淳 宜揚科技產品工程師 

– 黃舒鈺 華寶電子工程師 

– 林裕章 中研院基因鑑定中心軟
體工程師 

– 王思博 廣達電子工程師 

– 李如惠 連邦專利事務所工程師 

– 邱佳琳 揚智科技資深工程師 

– 曾啟榮 台電調度處工程師 

– 林志明 日月光電子工程師 

– 黃新興 東元電器工程師 

– 張書豪 三商電腦工程師 

– 林世國 再轉任高鐵工程師. 
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師生專利獲獎 
 2011年及201年馬來西亞創作展發明獎2面金牌 4面銀牌  

 

年度 已核准 

95年 2 

96年 2 

97年 18 

98年 23 

99年 16 

100年 11 

合計 72 

http://www.itex.com.my/about/index.php
http://www.itex.com.my/about/index.php
http://www.itex.com.my/about/index.php
http://www.itex.com.my/about/index.php
http://www.itex.com.my/about/index.php
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導師office hour與生活輔導 

導師office hour制度 

導師生活輔導、學習輔導（線上回報） 

心理輔導室輔導 

•電機系輔導老師  

各種獎助學金 

•特種獎學金 

•（乙級證照、日文2級…） 

•專業證照報名費補助 

•急難救助、弱勢助學… 
12

課後輔導

提供自學中心

實施補救教學
語文課程
輔導

導師暨授課
教師輔導

1. 學校自學中心
2. 系研討室

1. 雙語環境
2. 情境學習環境
3 . Coffee Shop
4. 英文雜誌研讀
5. 英文補救課程

重點人才
培育

1.導師時間
2. Office Hour

1. 個別輔導
2. e化重點課程

專題製作研究計畫
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學生獲獎 
101年北區技專院校 數學 微積分競賽「第一名」 

     羅治同老師 指導-嚴守一同學  
99學年度北區技職微積分競賽團體組工科優等獎 
•林秉棋、陳彥銘、劉晁綱 

99學年度北區技職微積分競賽個人組工科傑出獎 
•陳駿瑋 
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學生獲獎 
2011全國新興能源暨綠色能源專題創意競賽團體入
選獎-謝宗煌 指導-曹嘉祥、鍾嘉致、姜大駿、林祐
全 

2011年 全國波浪能轉換器創意實作競賽」榮獲「亞
軍」。謝宗煌 指導-吳彥瀚、楊子寬、劉怡均 
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大專生參與國科會計畫 

 

 

計畫名稱 起迄年月 學生-主持人 

太陽能與風能複合與市電並聯之研製 
 (NSC 96-2815-C-157 -004 -E) 96.7.1-97.2.29 林時沂-謝宗煌 

Fabey-Perot干涉式光纖生物感測器之研
製 (NSC 96-2815-C-157 -002 -E) 96.7.1-97.2.29 李偉裕 

以微機電技術製作可調式積體光學液晶
光補取多工元件 
 (NSC 96-2815-C-157 -001 -B) 

96.7.1-97.2.29 李昆益 

風力發電之變流器與市電並聯控制之研
究(97-2815-C-157 -005 -E) 97.7.1-98.2.28 林立凡-謝宗煌 

奈米狹縫光波導生化感測器之研究(97-

2815-C-157 -004 -E) 97.7.1-98.2.28 李偉裕 
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大專生參與國科會計畫 

 

 

計畫名稱 起迄年月 主持人 

利用一種複製技術製作高分子光波長濾
波器(97-2815-C-157 -003 -E) 97.7.1-98.2.28 李昆益 

以微機電氣泡式光開關實現免疫化學偵
測生物感測器之研究 (98-2815-C-157 -

002 -E) 
98.7.1-99.2.28 李偉裕 

磁滯電流控制法於綠色電能與市電併聯
之應用(99-2815-C-157 -003 -E) 99.7.1-100.2.28 曹家祥-謝宗煌 

含孤島檢測功能之電壓控制法於併聯變
流器之應用(100-2815-C-157 -001 -E) 

100.7.1-

101.2.28 

姜大駿-謝宗煌 
 

設計全新正弦脈波寬度調變變流器之控
制器應用於不斷電系統(100-2815-C-

157 -003 -E) 

100.7.1-

101.2.28 
羅鈺雯-陳世豐 
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升學（博班~部分資料） 
錄取學校 畢業 

學年度 
姓名 系所 

國立台灣大學 97 陳建君 應用力學所博士班 

97 林裕展 光電工程所博士班 

98 詹凱全 應用力學所博士班 

國立清華大學 93 陳峙華 光電博士班 

國立中央大學 96 楊宜斌 電機所固態組博士班 

98 楊宜誠 電機工程所博士班 

國立台灣科技大學 97 陳冠宇 光電工程所博士班 

98 簡達益 光電工程所博士班 

99 李政哲 電子所博士班第二名 

99 許海音 電子所博士班第五名 

101 周俊翰  電子所博士班 
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升學（碩班~部份資料） 
錄取學校 畢業學年度 姓名 系所 

國立台灣大學 101 謝君華  電機研究所 

國立台灣科技大學 95 魏孝哲 電機研究所(博士候選人) 

96 林時沂 電機研究所  

100 姜大駿 電機研究所 (備取) 

國立台北科技大學 94 黃舒鈺 光電所 

94 鄭理謙 技職所 

96 林時沂 電機研究所 

100 姜大駿  
李則霆 

電機研究所 (正取) 
冷凍與能源組 

國立海洋大學 93 張瑋倫 海洋輪機研究所 

94 黃富瑋 

96 林時沂 電機研究所 (錄取) 

97 林立凡 電機研究所 (榜首) 
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校外參訪 

台灣仿真科技股份有限公司(99.01.05)   
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校外參訪 

智慧財產法院(98.12.08)    
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2011馬來西亞發明展締佳績 教長表揚獲獎師生 

http://tw.news.yahoo.com/photo/url/d/i/110726/63/20110726_4707733/20110726_4707733.jpg.html
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http://www.youtube.com/watch?v=0g7gcZw

xo6o&feature=relmfu 

狂賀電機系李偉裕主任、李昆益老師帶領學生高
千勛、周俊翰與正能光電產學合作榮獲馬來西亞
2012年  ITEX發明展四面銀牌  



                    電機工程系-102年度宣導簡報  
2012年全國流能轉換器創意實作競賽榮獲亞軍 
 2012年北區技專院校微積分競賽第一名 
 



                    電機工程系-102年度宣導簡報 

 
2012全國能源科技創意實作競賽榮獲「特別獎」 

謝宗煌 楊瑞錶 林建隆教授指導 

  余冠衡 陳昱宏 陳昱任 王奕喆  
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高中申請入學：10人。 

技優：    電機類10人。     

甄選：    電機類45人， 

               資電類13人。 

登記分發:電機類19人， 

                機械群5人， 

                動力機械群10人。 

風雲再起(22歲高畢免試) : 5人 

一、日間部 二、夜間部 

名額37人: 
 電機群:9人， 

 機械群:2人， 

 動力機械群: 5人， 

 風雲再起(22歲高畢免試): 

15人 

 運動績優:6人 

                 

電機系- 四技招生核定員額 

http://cc.chit.edu.tw/cgi-bin/openwebmail/openwebmail-viewatt.pl/941G1017-%B7s%A4j%BC%D3-%A4j%BC%D3%B2M%B4%B7_%C1Y%A4p%A4j%A4p.jpg?action=viewattachment&sessionid=ypyang*cc.chit.edu.tw-session-0.538566604527695&message_id=%3C008c01c85756%24e97286a0%240d1da8c0%40ayuxpultra%3E&folder=saved-messages&attachment_nodeid=0-2&convfrom=none.big5


Android手機應用程式開發 

 

中華科技大學/電機工程系 

 

許地申 副教授  
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智慧型手機之商機 
 智慧型手機因為現今人們對手機的依賴度最深、黏著度最高，所以

智慧型手機即順理成章成了無線連網時代革命的第一波受惠者。  

 到了2012年時，智慧型手機的出貨量更高達5.2億支，其所佔整體手
機出貨比率將達3：1的高水平，背後所衍生出商機之龐大，包括硬
體方面整體手機生產出貨時的產值，與軟體方面在消費者應用軟體
與需求產生時附加價值，這些商機已經吸引許多廠商就其優勢進行
卡位動作。  

 台灣在兩岸關係日漸加溫的情況下，展望未來在中國市場上具有文
化及語言優勢，在中國快步邁向現代化和世界市場的同時，對於資
訊的反應速度與需求量呈現驚人的增長，藉中國卡位、升級，已成
為各大電子廠所必須鑽研的功課。  

 IDC：今年(2013)Android平板電腦出貨量將首度超越iPad 。   

 



Android簡介  
￭ Android是一款基於Linux 2.6核心的軟體平台和作業系統，
主要是由Google公司開發，之後Google和半導體、手機、通
訊服務等廠商建立了開放手機聯盟（Open Handset 
Alliance），共同為後續開發服務。  
￭ Android採用了軟體堆層（software stack，又名以軟體疊
層）的架構，主要分為三部分。底層以Linux核心實作為基礎，
提供最基本的功能；其他的應用軟體則由聯盟各公司自行開
發，採用Java作為開發語言。  
￭ 另外，為了推廣此技術，促進移動設備的不斷創新，讓用
戶體驗到最優質的移動服務，讓開發商得到一個新的開放級
別。  
￭ Android被作為一個完整、開放、免費的手機平台。所以，
Android手機作業系統受到了社會各界廣泛的關注。  
  



Android Logo 

 

http://pic.gamme.com.tw/397475/1


￭Android開發者挑戰賽(Android Developer Challenge)
是一個Goggle所舉辦之週期性的比賽，是開發人員利用
Android操作系統創建的應用程式。 
￭在Android開發者挑戰賽的參賽作品被分為多個不同的
類別，包括教育，社交網絡，生活方式，媒體和遊戲。
在2009年的第二屆Android開發者挑戰賽（ADC2），在
那場比賽中第一名獲得15萬美元，而第二名和第三個名
分別為50,000美元和25,000美元。 
￭「手機遊戲App大賽」10萬獎金等你拿！ 「CCMG 
Award2013手機遊戲App大賽」是以智慧型手機(Smart 
Phone)遊戲為主，不限遊戲類型，但需基於Android、
iOS作業系統，可於這兩套系統智慧型手機上所執行。 

http://www.wisegeek.com/what-is-an-android.htm


˙現在有機會用App重現2013 WBC經典賽熱情，可以打
敗日本、打爆古巴？可用App幫中華隊復仇。 
˙App能讓我們根據所在位置，查詢當地美食，這款軟
體能幫我們簡單備忘紀錄想去的景點地圖、資料、電
話；Line 是手機上非常熱門的免費傳訊軟體。 

˙醫療照護可預約與追蹤。 



智慧型手機之商機 



Android之商機  

2012年6月，Google在2012 Google I/O大會上表示
全球市場上有4億部Android設備被啟動，每天啟動
一百萬台。根據 Nielsen 調查報告，2012年6月調
查美國的手機使用者，有 54.9% 比例使用智慧型手
機，比起3月調查的 50% 多出近5個百分點。
Android 依然是最多人選擇的智慧型手機系統，以
51.8%領先群雄，分析 Andorid 手機的品牌中，又
以 Samsung 表現最為亮眼，擁有 17% 使用率，其
次為 HTC 的 14%、Motorola 的 11%。如下圖所示
。ICD更預測全球智慧型手持式裝置在2015年出貨量
將高達10億支。 

 



Android之商機  



Android 系統架構  
Android 系統架構主要是由五個部份所組成： 
應用程式(Applications)、應用程式架構(Application 

Framework) 、函式庫(Libraries)、Android 執行環境(Android 
Runtime)與 Linux 核心(Linux Kernel)， 
如下圖所示： 
 



Android 系統架構  
第一層：Linux核心層  
第二層：系統執行函式庫層  
第三層：應用框架層  
第四層：應用層  
￭1、應用層  
Android應用程式包是用JAVA語言開發的，執行在虛擬機上
的程式，它會同核心一起發佈，該應用程式包包括email用
戶端、SMS簡訊程式、日曆、地圖、瀏覽器、聯繫人管理程
式等。  
￭2、應用框架層  
Android應用框架層是開發人員在發佈核心應用時所使用的
API框架，該應用程式架構用來簡化元件軟體的重用；任何
一個應用程式都可以發佈它的功能塊並且任何其他的應用
程式都可以使用其所發佈的功能塊（不過得遵循框架的安
全性限制）。  
 



開發步驟與要領 



開發步驟與要領 

建立開發環境之前，必須先下載Android SDK元件、Eclipse以
及Java JDK(Java Development Kit)元件，因為Android的應用
程式是採用Java語言編寫的。相關的下載網址分別是：  
￭ http://www.oracle.com/technetwork/java/javase/ 
downloads/ (下載Java JDK)  
￭ http://www.eclipse.org/downloads (下載Eclipse)  
￭ http://developer.android.com/sdk/eclipse-
adt.html#downloading（下載ADT） 
 ￭ http://developer.android.com/sdk/index.html (下載Android 
SDK)  

 



開發步驟與要領 
 

Part1：開發環境建立 
要建立Android開發環境需要
安裝三個套件，分別為Java、
Eclipse和Android SDK，
Java是Android應用開發的程
式語言，而Eclipse套件為其
編輯環境，Android SDK為
Android開發工具。接著利用
Eclipse安裝外掛套件ADT 
Plugin，再來下載安裝所需
的Android版本，即完成整個
開發環境。  
Java SE 
到Oracle官網下載JDK，並將
其安裝。安裝完成會出現註
冊的頁面，直接關掉即可。 

http://www.oracle.com/technetwork/java/javase/downloads/index.html
http://www.oracle.com/technetwork/java/javase/downloads/index.html


開發步驟與要領 
 

Eclipse 
到Eclipse官網下
載Eclipse IDE 
for Java，若有需
開發J2EE的話，可
以選擇下載
Eclipse IDE for 
Java EE 
Developers，並將
其安裝。  

http://www.eclipse.org/downloads/
http://www.eclipse.org/downloads/


開發步驟與要領 
 

Android SDK 
到Android Developers下
載Android SDK，並將其
安裝。 
 
在安裝的過程中，若已安
裝JDK，但卻出現系統偵
測不到JDK的錯誤，則需
要額外設置系統變數，設
置過程稍微繁瑣，請多留
心。   

http://developer.android.com/sdk/index.html


開發步驟與要領 
 

ADT Plugin 
執行Eclipse，在
設置workspace的
畫面直接按下OK即
可，第一次執行可
選擇workbench跳
過軟體介紹。於
HELP內點選
Install New 
Software。  



開發步驟與要領 
 

點選右上的Add按
鈕會出現一個視窗，
在Name欄位的名稱
自取，而在
Location欄位上打
上: http://dl-
ssl.google.com/a
ndroid/eclipse，
並按下OK。 
 

http://dl-ssl.google.com/android/eclipse
http://dl-ssl.google.com/android/eclipse
http://dl-ssl.google.com/android/eclipse
http://dl-ssl.google.com/android/eclipse


開發步驟與要領 
 

此部分需稍待片刻，
直到出現
Developer Tools
時，再點其左邊的
三角型將其展開，
勾選DDMS和ADT(視
需求也可直接勾選
Developer Tools)，
按下NEXT，接著同
意license將其安
裝。  
 



開發步驟與要領 
 

安裝過程中可
能出現安全性
警告，按下OK
即完成安裝
ADT外掛套件。  
 



開發步驟與要領 
 

下載安裝
Android開發版
本 
執行Eclipse，
於Window內點選
Android SDK 
Manager。  
 



開發步驟與要領 
 

勾選所需的開
發版本、
Tools和
Extras按下
Install。  

 



開發步驟與要領 
 

點選Accept All後
再按下Install即
可開始下載安裝。
在安裝過程中若出
現存取被拒的錯誤，
其為權限不足所造
成，使用系統管理
員身分執行
Eclipse並重覆以
上步驟即可正常下
載安裝。   
 



開發步驟與要領 
 

建立AVD 
執行Eclipse，
於Window內點選 
AVD Manager，
接著於右上點選
New創造一個模
擬器。 



開發步驟與要領 
 

Name欄位為此模
擬器的名稱，
Target欄位選擇
模擬器的開發版
本，接著按下
Create AVD即可
創造出模擬器。 



開發步驟與要領 
 

接下來需將其更新，選擇一個模擬器後按下右方的Start，再點選Launch
如，系統會開啟模擬器，在開啟的過程中會花費許多時間，所以在程式
開發時，不將模擬器關閉，繼續運行可有效節省重開模擬器的時間。  



開發步驟與要領 
 

Part2：Android 操作上手 
在此部分將分別簡介如何建立
Android 程式、如何將專案運作於
模擬器上及如何使用既有專案匯入。
目前最迅速的開發方式建議為匯入
既有專案，因為很多程式早已有人
開發出來，只要尋求最接近我們需
要的程式再加以修改成自己的程式
即可。  
2.1建立Android程式  
建立Android專案方式如下: 
1. File -> New -> Project 
2. Android -> Android 
Application Project -> Next 
3. 在Application Name欄位上填
上Hello，再按Next 
4. Next –> Next -> Finish  



開發步驟與要領 
 

2.2將專案運作於模擬
器  
專案模擬方式如下: 
1. 在專案的root 目
錄上點滑鼠右鍵  
2. Run as -> 
Android Application  



開發步驟與要領 
 

2.3使用既有專案匯入  
匯入專案作法如下  
1.File -> Import 
2.General -> Existing 
Projects into Workspace -> 
Next 
3.按Browse選擇其路徑 -> 確
定  
值得注意的是在步驟3時，Copy 
projects into workspace 這
個選項，其可將專案複製到
workspace，讓開發者於測試修
改時不會更改到原本專案。  



快速學會開發Android App 

1.熟悉 Android 開發環境，模擬器，及如何
快速建立程式。 
2.了解Android生命週期與運作原理。 
3.手機事件與系統預設廣播訊息。 
4.協同硬體與Android O.S.軟體控制。 
5.使用者人機介面架構模型(互動視窗與訊息)。 
6.手機檔案管理與I/O存取。 
7.存取手機電信資料與識別。 
8.善用Android程式元件(Activity、Broacast 
Receiver、Service、Content     
Provider) 。 
  
 



Android特色 
 

1.快速上手易學習：免費、熟悉的跨平台開發工具，開發者
可在短時間內上手。 
 
2.開發想像無限大：Linux與Java語言結合的友善開發環境，
讓開發回歸創意原點。 
 
3.應用程式可攜式高相容性：解決應用程式與軟硬體衝突、
檔案格式流通問題。 
 
4.更好的使用者經驗：支援多種網路、影音多媒體等處理能
力，應用多元豐富。 



校園導覽  
為了使學生了解學校周圍環境與學校特色， 

以數位相框的方式表達學校發展與地理環境。 

點取圖案即可放出或切換相片。  



中華水果盤 

玩法：(改良式的跑燈型水果盤，模擬真機台， 
可陪玩家歡度無數時光。) 
 
1.點選金幣圖案。 
2.點選投幣孔以點選次數決定籌碼，每次10
元。 
3.點選下端欲押注的圖案以點選次數決定倍
率。 
4.點選GO，開始遊戲，執行時並有聲音伴隨。 
5.核算彩金是否賺或賠？ 
 
  



BMI身高體重指數 

w = 體重，單位：公斤; 
h = 身高，單位：米; 

健康狀況 
BMI 值 

女性 男性 

一般體重 18.5到24.9之間 

理想體重 22 24 

超重 25到29.9之間 

嚴重超重 30到39.9之間 

極度超重 40以上 



結論  

˙iPhone與Android或window 8等智慧型手機的普
及化，更深化了手機對人們生活方式的影響。 
˙Android是一個發展快速、普及率遽增智慧型手
機作業系統，它具有彈性可擴充軟體的功能。 
˙開發達到簡易的操作理念，使客戶能快速上手。 
˙start now. 

 



Thanks for your attention. 



 
      動畫設計實務— Adobe Flash  

中華科技大學/電機工程系 

 

柯德祥   副教授  
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1 動畫設計觀 

好萊塢的動畫大片每年都會在全球捲走十幾億美金的票
房；而日本的電玩遊戲更是到了沒CG動畫就上不了檯面
的地步；動畫風潮可謂是風靡全球。然而，這些奇妙的
動畫是如何被創作出來的呢？在設計動畫的時候又應該
注意些什麼呢？ 

 動畫的實現 

 動畫製作流程 

 動畫類型 

下一頁 上一頁 回目錄 下一節 



動畫的實現 

動畫被分解後，只不過是一張張靜態的影像而已，所以
動畫實質上就是由這些連續、變化的靜態畫面所組成的。
動畫的構成原理和電影相似，都是利用人眼的視覺暫留
現象，讓靜態的畫面產生動態的效果。 

下一頁 上一頁 回目錄 



動畫製作流程 

動畫是靠快速播放相似的影像來呈現，但動畫的製作並
非只是繪圖那麼簡單。一般而言，完整的動畫製作要分
成3個階段，即前期製作、中期製作和後期製作。而動畫
設計則包括劇本、人物設計、場景設計、原畫、分鏡、
動畫、修形、動畫檢查、後期製作等步驟。 

下一頁 上一頁 回目錄 



動畫類型 

現在流行的動畫分為2D動畫和3D動畫兩種。不同類型的
動畫，其設計和製作有很大的區別。 

2D動畫 

 2D動畫的人物設計和背景皆是平面的圖形，因
此無法呈現真實的立體感。 

3D動畫 

 在製作3D動畫物件時，要精細地考慮到物件的
各面形狀、材質、光線、顏色層次，以展現出
適當的物件立體效果。 

下一頁 上一頁 回目錄 



2 常見動畫設計軟體介紹 

了解動畫是由視覺暫留形成，整個動畫製作的過程、分
類和各種類型動畫常用的設計軟體，這些軟體有什麼不
同？又如何在眾多軟體中挑選符合自己需求的呢？本節
將為您帶來這些問題的答案。 

 Flash動畫創意設計軟體 

 3ds Max電腦動畫設計軟體 

 Maya 3D電腦動畫設計軟體 
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Flash動畫創意設計軟體 

Flash可以將音樂、音效、動畫融合，製作出高品質的動
態影像，並且可以建立和使用者互動的內容，例如測驗、
遊戲等。 
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3ds Max電腦動畫設計軟體 

3ds Max是世界上應用最廣泛的3D建模、動畫、繪圖軟體，
由Autodesk公司推出，並廣泛應用於遊戲開發、角色動
畫、視覺效果和設計行業等領域。 
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Maya 3D電腦動畫設計軟體 

Maya由Alias公司在1998年推出，是目前最為優秀的3D動
畫製作軟體之一。其技術超前但卻操作複雜，廣泛應用
於電影、電視、廣告、電腦遊戲和電視遊戲等數位特效
創作上。 
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3 認識Flash 

Flash具有向量繪圖與2D動畫製作的功能，即使不會設計
和編寫程式，依然可以透過Flash輕鬆地製作出動畫。 

 功能特色 

 視窗介面 

 操作基礎和原理 
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功能特色 

繪製向量圖形 

 Flash擁有多種向量圖形繪製工具，還可利用
「選取工具」和「選取細部工具」調整圖形。 

動畫設計 

 動畫設計是Flash軟體最重要的功能之一，除了
製作逐格動畫外，還提供了各種補間動畫，便
於設計者快速建立位置、大小、形狀、色彩、
透明度變化等動畫效果。 
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功能特色 

互動網頁 

 透過Flash所製作的眾多元素，使網頁在強烈的
動態效果下，達到吸引瀏覽者目光的目的。 

動畫格式 

 每一套設計軟體都會有屬於自己的檔案格式，
Flash當然也不例外。 

 1) FLA 

 2) SWF 

 3) EXE 
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視窗介面 

作為一套強大的動畫創意設計軟體，Flash的操作卻異常
簡單，其操作環境設計也頗為人性化。 

 起始頁 

 工具列 

 「時間軸」面板 

 場景工作區 

 「屬性」面板 
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起始頁 
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工具列 
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「時間軸」面板 
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場景工作區 
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「屬性」面板 
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操作基礎和原理 

在開始使用Flash設計動畫之前，還必須認識影格、圖層
與時間軸這三項必備的使用基礎觀念。 

 影格 

 圖層 
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影格 
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圖層 
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4 動畫設計實務 

 4-1 廣告橫幅設計 

 4-2 設計導覽按鈕 

 4-3 Loading載入動畫設計 

下一頁 上一頁 回目錄 下一節 上一節 



4-1 廣告橫幅設計 

只要瀏覽網頁，幾乎就離不開出現在網頁最上方的廣告
橫幅。在這些廣告中，只要是會動的，幾乎都出自於
Flash。 

 Step1. 新增Flash檔案(ActionScript3.0) 

 Step2. 輸入「背景1」文字內容變更圖層名稱 

 Step3. 分別拖曳導引線到文件邊 

 Step4. 繪製矩形作為背景 

 Step5. 選取矩形設定矩形為圖像元件 

 Step6. 插入關鍵影格執行「建立傳統補間動畫」 
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4-1 廣告橫幅設計 

 Step7. 新增圖層並插入選取的素材圖片到舞台 

 Step8. 按住Shift鍵等比例放大圖像完全遮住舞台 

 Step9. 開啟「轉換成元件」對話方塊設定Alpha值 

 Step10. 插入選取素材圖片並調整圖像到舞台下方 

 Step11. 設定名稱、類型 

 Step12. 調整人物影像，設定人物元件Alpha為「0」 

 Step13. 執行「清除影格」功能，選取前面所有影格
建立傳統補間動畫 

 Step14. 新增「包裝設計」圖層台並轉換成元件 
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4-1 廣告橫幅設計 

 Step15. 插入關鍵影格 

 Step16. 為所有影格建立傳統補間動畫 

 Step17. 鎖定「背景2」圖層新增「Logo背景2」圖層 

 Step18. 新增「大聲公」圖層調整元件位置 

 Step19. 插入關鍵影格調整元件位置 

 Step20. 鎖定「大聲公」圖層並新增「波紋」圖層 

 Step21. 按下F8功能鍵設定名稱為「波紋」開始編輯 

 Step22. 插入關鍵影格複製圖形 
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4-1 廣告橫幅設計 

 Step23. 按照同樣的方式新增圖形 

 Step24. 移除第94~173影格 

 Step25. 鎖定「波紋」圖層並新增「文字」圖層 

 Step26. 選取「末日色計展」編輯文字形狀 

 Step27. 拖曳選取「末」字的上端並向上拖曳 

 Step28. 選取所有文字內容，按下Ctrl+G快速鍵群組 

 Step29. 在第92影格插入關鍵影格並調整文字群組的
位置 
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4-1 廣告橫幅設計 

 Step30. 分別插入關鍵影格，並拖曳變形文字群組 

 Step31. 鎖定「文字」圖層新增「文字遮色片」圖層 

 Step32. 新增「日期」圖層 

 Step33. 放大文字、調整文字位置 
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廣告橫幅設計 

Step1. 新增Flash檔案(ActionScript3.0) 
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廣告橫幅設計 

Step2. 輸入「背景1」文字內容變更圖
層名稱 
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廣告橫幅設計 

Step3. 分別拖曳導引線到文件邊 
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廣告橫幅設計 

Step4. 繪製矩形作為背景 
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廣告橫幅設計 

Step5. 選取矩形設定矩形為圖像元件 
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廣告橫幅設計 

Step6.插入關鍵影格執行「建立傳統補
間動畫」 
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廣告橫幅設計 

Step7. 新增圖層並插入選取的素材圖片
到舞台 

下一頁 上一頁 回目錄 



廣告橫幅設計 

Step8. 按住Shift鍵等比例放大圖像完全
遮住舞台 
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廣告橫幅設計 

Step9. 開啟「轉換成元件」對話方塊設
定Alpha值 
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廣告橫幅設計 

Step10. 」插入選取素材圖片並調整圖
像到舞台下方 
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廣告橫幅設計 

Step11. 設定名稱、類型 
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廣告橫幅設計 

Step12. 調整人物影像，設定人物元件
Alpha為「0」 
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廣告橫幅設計 

Step13. 執行「清除影格」功能，選取
前面所有影格建立傳統補間動畫 
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廣告橫幅設計 

Step14. 新增「包裝設計」圖層台並轉
換成元件 
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廣告橫幅設計 

Step15. 插入關鍵影格 
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廣告橫幅設計 

Step16. 為所有影格建立傳統補間動畫 
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廣告橫幅設計 

Step17. 鎖定「背景2」圖層新增「Logo
背景2」圖層 
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廣告橫幅設計 
Step18. 新增「大聲公」圖層調整元件位置 
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廣告橫幅設計 

Step19. 插入關鍵影格調整元件位置 
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廣告橫幅設計 

Step20. 鎖定「大聲公」圖層並新增
「波紋」圖層 
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廣告橫幅設計 

Step21. 按下F8功能鍵，設定名稱為
「波紋」開始編輯 
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廣告橫幅設計 

Step22. 插入關鍵影格複製圖形 
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廣告橫幅設計 

Step23. 按照同樣的方式新增圖形 
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廣告橫幅設計 

Step24. 移除第94~173影格 
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廣告橫幅設計 

Step25. 鎖定「波紋」圖層並新增「文
字」圖層 
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廣告橫幅設計 
Step26. 選取「末日色計展」編輯文字形狀 
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廣告橫幅設計 

Step27. 拖曳選取「末」字的上端並向
上拖曳 
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廣告橫幅設計 

Step28. 選取所有文字內容，按下Ctrl+G
快速鍵群組 
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廣告橫幅設計 

Step29. 在第92影格插入關鍵影格並調
整文字群組的位置 
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廣告橫幅設計 

Step30. 分別插入關鍵影格並拖曳變形
文字群組 
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廣告橫幅設計 

Step31. 鎖定「文字」圖層新增「文字
遮色片」圖層 

下一頁 上一頁 回目錄 



廣告橫幅設計 

Step32. 新增「日期」圖層 
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廣告橫幅設計 

Step33.放大文字、調整文字位置 
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4-2 設計導覽按鈕 

要設計Flash動畫按鈕，必須先建立「按鈕」元件，然後
在該元件中的「一般、滑入、按下、感應區」四種編輯
狀態下，編輯相關按鈕內容。 

 Step1. 新增Flash檔案(ActionScript2.0)開始練習。 

 Step2. 變更圖層名稱為「背景」 

 Step3. 從舞台左上方向右下方拖曳繪製矩形 

 Step4. 按下F8功能鍵將矩形轉換成元件 

 Step5. 按照同樣的方式設定內部矩形 

 Step6. 開啟尺規並拖曳垂直導引線到舞台正中間 
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4-2 設計導覽按鈕 

 Step7. 將素材圖片匯入至元件庫 

 Step8. 新增圖層變更名稱為「按鈕」 

 Step9. 對齊所有按鈕元件 

 Step10. 選取第1個按鈕設定名稱為「下載」 

 Step11. 拖曳導引線貼近元件邊緣 

 Step12. 在「滑入」影格執行「插入關鍵影格」 

 Step13. 刪除文字內容並將元件調整到一般位置 

 Step14. 按照同樣的方式製作其他按鈕 

下一頁 上一頁 回目錄 



設計導覽按鈕 

Step2. 變更圖層名稱為「背景」 
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設計導覽按鈕 
Step3. 從舞台左上方向右下方拖曳繪製矩形 
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設計導覽按鈕 

Step4. 按下F8功能鍵將矩形轉換成元件 
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設計導覽按鈕 

Step5. 按照同樣的方式設定內部矩形 
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設計導覽按鈕 

Step6. 開啟尺規並拖曳垂直導引線到舞
台正中間 
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設計導覽按鈕 

Step7. 將素材圖片匯入至元件庫 
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設計導覽按鈕 

Step8. 新增圖層變更名稱為「按鈕」 
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設計導覽按鈕 

Step9. 對齊所有按鈕元件 
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設計導覽按鈕 
Step10. 選取第1個按鈕設定名稱為「下載」 
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設計導覽按鈕 

Step11. 拖曳導引線貼近元件邊緣 
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設計導覽按鈕 

Step12. 在「滑入」影格執行「插入關
鍵影格」 
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設計導覽按鈕 

Step13. 刪除文字內容並將元件調整到
一般狀態位置 
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設計導覽按鈕 

Step14. 按照同樣的方式製作其他按鈕 
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4-3 Loading載入動畫設計 

在網站首頁出現之前的等待期間，藉由簡易有趣的動畫
與載入進度，讓瀏覽者不會覺得太過無趣而取消瀏覽。 

 Step1.開啟「載入動畫設計.fla」範例檔案 

 Step2. 新增並變更圖層名稱為「Loading」 

 Step3. 將矩形轉換成名稱為「percent」的影片片段 

 Step4. 將元件轉換名稱為「Loading」的影片片段 

 Step5. 雙擊元件開始編輯 

 Step6. 拖曳文字框設定字體 

 Step7. 新增「動作」圖層完成程式碼設定 
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Loading載入動畫設計 

Step2. 新增並變更圖層名稱為「Loading」 
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Loading載入動畫設計 

Step3. 將矩形轉換成名稱為「percent」
的影片片段 
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Loading載入動畫設計 

Step4. 將元件轉換名稱為「Loading」的
影片片段 
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Loading載入動畫設計 

Step5. 雙擊元件開始編輯 
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Loading載入動畫設計 

Step6. 拖曳文字框設定字體 
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Loading載入動畫設計 

Step7. 新增「動作」圖層完成程式碼設定 
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5 結論 

 1.Flash是一種設計創作軟體，設計人員和開發人員可
使用它來建立動畫、應用程式和其它能與使用者互動的
內容。 

 2.2D動畫有X軸和Y軸，只能表現物體的寬和高；而3D
動畫空間比2D動畫空間多出一個座標軸，包括了X軸、
Y軸和Z軸，這樣物件便有了前後及景深的效果。 

 3.在Flash的舞台中，可能要將多張圖重疊在一起產生
先後距離感，如背景、靜物、人物等等，這些不同的影
像可包含在不同的圖層中。在一個圖層上繪製及編輯物
件，不會影響另一個圖層上的物件。 
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5 結論 

 4.Flash可以輸出三種格式的成果檔案，即.SWF、.FLA
和.EXE。FLA格式的優點是可隨時用Flash編輯內容；
SWF格式的優點是檔案容量小，而且不會因為壓縮而影
響圖形品質；EXE格式的優點是可在Windows系統中直
接播放。 

 5.影格可以分為三類：一般影格、關鍵影格和空白關鍵
影格。 

 6.在Flash中，使用者可利用Action Script做出諸多的特
殊效果，如在範例中，借助Action Script製作Loading進
度條。 
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